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SOFTWARE LICENSE AGREEMENT 
This document is a legal agreement  between the user, who is the licensee, and Securit 
World. By using this program, the licensee is obliged to fulfill the terms of this 
agreement. If you, the user, do not agree with the terms of this agreement, please 
return this product in its original package with payment receipt, within 14 days to 
your retailer. 
By paying the retail price, the buyer pays the License fee to Securit World Ltd.  
Securit World Ltd grants the licensee a non-exclusive right - without the right to sub-
license - to use this copy of the software on one single computer. Securit World Ltd 
reserves all rights not specifically granted, and retains title and ownership of the 
software, including all subsequent copies in any media. 
The software and it’s accompanying written materials are copyrighted. You may copy 
the software solely for backup purposes; all other copying of the software or written 
materials is strictly forbidden. 
As the only warranty under this agreement, and in the absence of accident, abuse or 
misapplication, Securit World Ltd warrants, to the original licensee, only that the 
disks on which the software is recorded, are free from defects in materials and 
workmanship under normal use and service for a period of 90 days from the date of 
payment as indicated on the payment receipt. Securit World’s only obligation under 
this agreement is to either return the purchase price as indicated on the payment 
receipt or replace the disk that does not meet Securit World’s limited warranty and 
which is returned to Securit World Ltd with the payment receipt. 



 

GENERAL 

Acknowledgement 
At Securit World we are committed to design and develop the highest quality 
software and service. 
We would like to thank all the people who have contributed their talent, intellect and 
heart to produce this product. 

Copyright 
Information in this document is subject to change without notice and does not 
represent a commitment on the part of Securit World. The software, which includes 
information contained in any databases, described in this document is furnished under 
a license agreement or nondisclosure agreement and may be used or copied only in 
accordance with the terms of that agreement. It is against the law to copy the software 
except as specifically allowed in the license or nondisclosure agreement. No part of 
this manual may be reproduced in any form by any means, electronically or 
mechanical, including photocopying and recording, for any purpose without the 
written permission of Securit World Ltd. 
© 1993, 1994, 1995, 1996, 1997, 1998 Securit World Ltd, All rights reserved. 
  

Trademarks 
BadgeMaker, Securit 500, Securit 5000, Securit 5400, Securit 5500, Securit 6000, 
BM, DBLC, BC etc. are trademarks of Securit World Ltd. 
Windows is a trademark of Microsoft Corporation.  
All other trademarks are the property of their respective holders and are hereby 
acknowledged. 

System requirements 
BM6000 OLE requires Windows NT 4.0 to run and can be used on any IBM 
compatible computer that meets the following minimum requirements: 
100 MHz Pentium Processor or better 
200 Mb Hard Disk 
32 Mb Internal memory 
SVGA 800x600, 64K Colors 

Registering your software 
Be sure to register your version of BM6000 OLE to continue to receive information 
about updates from Securit World. You can register by mailing in the on the last page 
of this manual included registration card, or faxing your card in to +44 (0)208 203 
1027. 
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INSTALLATION 
Before installing the software, make sure your BM6000 OLE package is complete. 
It should consist of: 
• BM6000 OLE server  
• BM6000 SDK  
• Memo Key 1x 
• Getting started manual 1x 
 
• A digitizer board and digital video camera are optional available 
 
There are two setups for the BM6000: 
1. Setup for BM6000 OLE server 
2. Setup for BM6000 SDK 
 
The setup for BM6000 OLE server should always be runned. The setup for the SDK 
is for the developers to do the integration with their own application. Since the end 
user will not use the SDK, the SDK is delivered with a separate setup. In the 
following part the installation of the BM6000 OLE server and the BM6000 SDK is 
discussed.  
 
Please install the BM6000 OLE server first! 
 
The BM6000 has been developed for Windows NT but will also function under 
Windows 95. When installing under Windows NT, make sure to log in as a system 
administrator, otherwise the BM6000 cannot be installed. 
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Installation of the BM6000 OLE server 
Insert the Securit World CD in the CD-Rom drive. Select BadgeMaker software from 
the main menu and then ‘BadgeMaker 6000 OLE 2 Server 32 bit’. Windows will start 
the installation program: 
 

 
 

Type in your name and company name in the following dialogue: 
 

 
 

Click next to continue. 
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The next dialogue will show the default installation directory: 
C:\Program Files\ScreenCheck B.V.\BM6000 OLE Server 
 
Click ‘Next’ to accept this directory or click ‘Browse’ to select another directory. 
 
The following dialogue will show the default Program Folder (BM6000 OLE Server), 
click ‘Next’ to accept this folder, select another folder from the list or type in a name 
for a new folder. 
 
Now the program files will be copied. When the program files are copied the 
following dialogue will be displayed. 
 

 
 

Click ‘Finish’ to complete the setup. 
Now the BM6000 OLE Server is installed. The next step is to install the BM6000 
SDK disk. 
 
 

Installation of the BM6000 SDK 
Insert the BM6000 SDK disk into your floppy drive. Select Add/Remove Programs 
from ‘Control Panel’. Windows will search for the SETUP.EXE. Click next to 
continue. 
The following  dialogue will be displayed: 
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Click ‘Next’ to continue. 
The next dialogue will show the default installation directory: 
C:\Program Files\ScreenCheck B.V.\BM6000 SDK 
 
Click next to accept the default directory or click ‘Browse’ to select another directory. 
Now select the Setup type. Typical, Compact or Custom can be selected. The typical 
and compact installation will install all files. If you select ‘Custom’ the following 
dialogue will be displayed: 
 

 
 

The Twain sample source is TWAIN driver which can load BMP files in BM6000. 
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The Client-Server demo is a demo application with a few records to run the BM6000 
OLE server with as a help to integrate the BM6000 in your own application. 
 
Check the Implementation help file for a more detailed description of these modules. 
 
Click next to continue. Now the default Program Folder will be presented. Click 
‘Next’ to accept this program folder, select another folder from the list or type in a 
new program folder name to change the default program folder. 
 
Now the program files will be installed. Click ‘Finish’ on the last dialogue to 
complete the installation. 
Do not forget to connect the green dongle to your parallel port. Without the dongle 
connected the BM6000 will have a limited functionality (demo mode). 
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THE BM6000 COMPONENTS 
In this chapter a global description of the main components of the BM6000 OLE 
software is given and is indicated where they can be found.  A more detailed 
description is given in the help files supplied with the BM6000. 
 

Where to find the different BM6000 components? 
If you installed the OLE server and the SDK in the default directories you will have a 
subdirectory ‘BM6000 OLE Server’ for the OLE server and a subdirectory ‘BM6000 
SDK’ for the SDK. 
In the BM6000 OLE Server directory you will find the following: 
• program files for the OLE server 
• program files for the badge creator (card layout creator) 
• a help file for the BM6000 OLE server 
• a help file for the badge creator 
• a Badges directory with sample card layouts 
• a Data directory with setting files for the client application 
• a Stand alone data directory 
 
In the BM6000 SDK directory you will find the following: 
• a Client-Server Demo directory with the client demo application and data files 
• an SDK BM6000 directory with the ImGuideHelp.hlp file 
• a VB Client Source Code directory with the source code of the demo application 
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DESCRIPTION OF THE MAIN BM6000 COMPONENTS 
This paragraph will give a basic description of the functions of the BM6000 
components as mentioned in the last paragraph. 
For a detailed description see ImGuideHelp.hlp help file. 
 

The OLE Server 
The OLE Server can be started from the OLE Server or SDK program folder or by 
double clicking the BM6000.EXE. When the server is started, you will see the 
following Window: 
 

 
 
The BM6000 OLE Server can handle the following commands: 
• Photo: activates the selected Twain driver to acquire a photo from a Twain source 
• Signature: activates the selected Twain driver to acquire a signature from a Twain 

source 
• Convert: converts an image to a 256 color image file 
• Print: prints a card by using the selected badge layout 
• Preview: displays a preview of the current badge on the screen 
• Change printer: enables the user to select a printer to use with BM6000 
• Select photo source: displays dialogue with available TWAIN sources, user can 

select required TWAIN source for acquiring photos 
• Select signature source: displays dialogue with available TWAIN sources, user can 

select required TWAIN source for acquiring signatures 
 
When these command are used, the OLE server returns a message.  
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The Badge Creator 
The Badge Creator can be started from the OLE Server or SDK program folder or by 
double clicking the BC.EXE. When Badge Creator is started, you will see the 
following Window: 
 

 
 

From the ‘File menu’ select ‘New layout’ to create a new layout or ‘Open layout’ to 
open one of the 3 sample layouts delivered with the BM6000. 
 
Let us start by opening the ‘Visitors badges’ layout. Now all buttons except for the 
‘Save’ button are available. The ‘Save’ button is accessible as soon as any change has 
been made in the layout. The most frequently used options in BC, can be accessed by 
clicking the buttons on the button bar. These  options are also available in the menus 
together with the more advanced options. 
 
When the ‘Visitors badges’ layout is opened, the following window will be displayed: 
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By clicking on an item, an item can be selected. Positioning can be done by dragging 
a selected item by mouse. By double clicking on an item, the properties can be 
changed. By using one of the buttons, items can be added, a new or another badge can 
be opened, or the current badge can be saved. In the options menu, system settings 
(default font, color, zoom and grid) can be made, as well as magstripe and chip 
information can be included and a vertical and horizontal reference line can be set to 
align more than one items at a time. 
Click on save to store the changes to the current layout or to store a new created 
Badge as a .BC file. 
With the right mouse button the user can activate the following menu: 
 

 
• Copy: use copy to copy a selected item to the clipboard 
• Paste: user paste to paste an item from the clipboard into the layout (is only 

available when an item was copied to the clipboard). 
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• Delete: deletes the currently selected item. 
• Zoom in: zooms in on the current badge (available when not completely zoomed 

in). 
• Zoom out: zooms out on the current badge (available when not completely zoomed 

out). 
• Edit badge layout: enables the user to correct the basic settings of the current badge 

layout. 
• Snap to reference line: aligns the selected item to the defined reference line (only 

available when an item was selected). 
The scroll bars can be used to position the layout if it does no fit on the screen 
anymore (e.g. after zooming in). 
For a detailed description for all the functions refer to the help file in the Help menu. 
The help file gives an explanation for every item in the different menus of 
BadgeCreator. 
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The client demo 
In the BM6000 SDK folder you will find the Client Demo. The Client Demo is what 
the name already indicates a demo application to show how the command for the 
BM6000 OLE server can be implemented. 
 
When the client demo is started the dialogue presented will look as follows: 
 

 
 

The client demo has three records and three card layouts to test with. The photo and 
signature can be displayed. After first time installation there is no photo or signature 
displayed. With the View menu, you can switch between the three records. The 
‘Convert’ command converts one of the three sample photos/signatures to BMP, so it 
will be displayed in the ‘photo’ and ‘signature’ window of the client demo. If a new 
photo or signature is acquired with the ‘Photo’ or ‘Signature’ command in the client 
demo, it will also be converted to BMP to display it directly. 
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USING THE HELP FILES 
In order to keep the documentation quickly updatable and to have it right at your 
disposal, most of it can be found in the help files (in Windows help format). 
 
The following help files are available: 
BC.HLP   can be started from BadgeCreator 
BM6000.HLP   can be started from the BM6000 OLE Server 
IMGUIDEHELP.HLP  can be started from the Windows Explorer 
 
 

The BC.HLP file 
The help file for BadgeCreator (BC) can be started from the ‘Help’ menu of BC or 
from Microsoft Explorer. It contains help topics based on the menus. So for every 
menu item, there is a help text in the help file. Below a sample is displayed of the help 
topics in the File menu. 
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Per option detailed information is available: 

 
 

The BM6000.HLP file 
 
The help file of the BM6000 OLE server gives a short description of the menu 
options. 
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The ImGuideHelp.hlp file. 
The implementation help file is the most important help file of the three. It supplier 
the integrator with the necessary information how to implement the commands in his 
(existing) application. 
 
Below you will find an example of the description of the BM6000 project file: 
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VISUAL BASIC  CLIENT SOURCE CODE 
Apart from the BM6000 Client Demo application, on the SDK disk also the source 
code for the client demo is included. The source code can be used as an example to 
implement the BM6000 in an existing application. The demo application is written in 
Visual Basic 4.0. 
 
Below the main form is displayed and a fragment from the programming code: 
 

 
 
The comment lines (displayed in green) give an explanation of the commands to make 
it easy to integrate your own application. 
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